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1. Content 

 

What’s New in Oracle RDC 4.6 

 

Oracle RDC 4.6.0 is a fully web-enable interface: eCRF can be accessed from any qualified computer without 
installing additional software. 

 

Interface has been improved on several points regarding previous versions of Oracle RDC:  

 Conflicts between data entry and batch validation executing minimized 

 Access restricted 

 Possibility of a flexible study design (dynamism per page or visit) 

 Conditional branching (dynamism per variable) 

 Hidden discrepancies or protect (read only) 

 

 

Important 

Please remember you are not authorized to access an eCRF prior to receiving training to the 
appropriate version of the system. This training can be an eLearning, a face-to-face training session 
or a demonstration by an authorized user. At the end of the training, you will receive a certificate that 
should be kept in your study file. 
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Getting Help 

 

Getting Help with the eLearning 

 

A general Oracle Clinical RDC 4.5.3/4.6 eLearning is published on the Internet Portal provided by Quintiles. 
This eLearning is organized in short modules that demonstrate how to perform specific activities according to 
your role on the study. This eLearning will remain accessible during the course of your study, even after its 
initial completion: you can access any modules at any time if you need to review some specific processes. 

Getting Help with this Manual 

 

This manual is intended for a day-to-day use. It will help you in remembering activities and options learned 
during the eLearning or any other formal demonstration. It also contains some tips and information about the 
product features or some processing instructions. Please refer to the table of content to identify the section 
that suits your needs. 

Getting Help with the Oracle RDC Onsite 4.6 Online Help 

 

Online generic help functionality is accessible from Oracle RDC 4.6. This help file is the most complete one, it 
also means that it contains many information that do not fit specifically to your role on the study. You can 
refer this online help at any time via the ‘Help’ link in the right upper corner of Oracle RDC 4.6 main window 
(see Figure 1: Oracle RDC Onsite 4.6 Online Help 

). 

 

 

Figure 1: Oracle RDC Onsite 4.6 Online Help 

Getting Help with the Helpdesk 

 

If none of the supports described above answers your questions about Oracle RDC 4.6, do not hesitate to 
contact your dedicated helpdesk or your study representative. Either they will give you an answer or put you 
through to the appropriate person. For specific helpdesk contact information, go to your Study ePortal.
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2. Getting Started with Oracle RDC 

Starting and Closing Oracle RDC 4.6 

 

Click on the Web link available on your study ePortal or enter the Web address provided by the Sponsor. 
Web address can be added to your favorites list to start quickly next sessions. 

The system prompts for a User Name and Password: enter those provided by the Sponsor. 

 

 

Information 

The password is case sensitive, identifier should be entered exactly the same way it has been sent you. 
Please check if your keyboard is in upper or lower case, or if the numeric pad is activated before typing it. 
Special characters are not taken into account in eCRF identifiers. If you fail to connect or you lock your 
account with too many unsuccessful attempts, contact your helpdesk to reset your password. 

 

 

From the RDC interface, click ‘Logout’ in the header of the window to close the application (see Figure 2: 
Close Application 

 

 

 

Figure 2: Close Application 

 

Important 

Always use the ‘Logout’ button. Do not close the window of your Internet browser to leave the 
application; it may expose the system to security issues and tampering.  

When navigating in the Data Entry Window of Oracle RDC, always close the window with the red 
cross / white bottom. If you close the window with the ‘Close’ button of your web browser, changes 
will not be taken into account (see Figure 3: Close Data Entry Window). 

 

 

Figure 3: Close Data Entry Window
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Navigate Through Tabs 

 

Oracle RDC 4.6 main window is made of several tabs, each one containing distinct links or information.  

 

 

Figure 4: RDC Homepage tabs 

 

4 main tabs are accessible from RDC Homepage (see Figure 4: RDC Homepage tabs): 

 HOME: Page displayed immediately after log in. It contains links to reach main activities available 
according to your profile. 

 CASEBOOKS: New entry of eCRF pages is available from this tab only. It is the easiest way to 
access eCRF pages that should be modified. 

 REVIEW: It proposes to perform several types of actions on pages already entered via 4 sub-tabs 
(‘CRFs’, ‘Discrepancies’, ‘Investigator Comments’ and ‘Special Listings’). Except initial entry, all 
other activities could be managed from this tab. 

 REPORTS: Display options to generate a Patient Data Report (eCRF book with patient pages) or a 
blank eCRF. 

 

Exploring Tab ‘Home’ 

 

This tab contains several areas (see Figure 5: RDC Homepage): 

 NEWS: This area displays messages addressed to all RDC users or specifically to the user 
logged to the system. Follow the link to display the message. 

 ACTIVITIES: Depending on profile logged to the system, this notification area displays all activities 
available regarding eCRF management. Each link will bring the user to the appropriate section of 
the ‘Review’ tab, with filters pre-entered to manage the due tasks. 

 LINKS: Predetermined web links are available in this area. 

 LOGIN INFORMATION: This notification area displays the name and login of the user logged to the 
system, and associated profile (investigator, CRA, Sponsor …). If information reported is not 
accurate, contact immediately your helpdesk. 

 FILTER INFORMATION: Drop-down lists to select studies and sites you will work on (if any). Mostly 
used for users with multi-sites responsibilities (CRA, Medical reviewers …) 

 SEARCH: Expand this area to access simple filters about patients to retrieve: patient number, new 
or existing patients, eCRF book assigned, and discrepancy status. ‘Activities’ links are more 
convenient to perform simple tasks, and ‘Search’ menu from ‘Casebooks’ tab is more complete, 
so you wouldn’t need to use it so often. 

 PATIENTS SELECTION: Area that displays patients available for study conduction for a specific site.  
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Figure 5: RDC Homepage 

 

Exploring Tab ‘Casebooks’ 

 

This tab Casebooks (see Figure 6: RDC Tab 'Casebooks') is intended for a data entry purpose. It contains 2 
main sections: 

 SEARCH: A filter applied in this section modifies data displayed in the following one.  

 ECRF NAVIGATION AREA: In this area, each patient is represented by one row, and each column 
represents a single page available for the corresponding visit. Click in a cell of this grid to open 
the corresponding eCRF page for a given patient. 

 

Figure 6: RDC Tab 'Casebooks' 
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Exploring Tab ‘Review’ 

 

This tab Review is intended for all kind of data review activities. It contains 4 sub-tabs containing the same 
Search area: 

 CRFS: (see Figure 7: RDC Tab ‘Review’ - CRFs) It allows a review of all entered eCRF pages 

DISCREPANCIES: (see Figure 8: RDC Tab 'Review' - Discrepancies 

 ) Discrepancy management is done from this page 

INVESTIGATOR COMMENTS: (see Figure 9: RDC Tab 'Reviews' - Investigator Comments 

 ) This tab summarize all investigator comments entered on eCRF pages. 

 SPECIAL LISTINGS: (See Figure 10: RDC Tab 'Reviews' - Special Listings) This section contains 
listings for MEDDRA and WHODRUG coding. 

 

 

Figure 7: RDC Tab ‘Review’ - CRFs 
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Figure 8: RDC Tab 'Review' - Discrepancies 

 

 

Figure 9: RDC Tab 'Reviews' - Investigator Comments 
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Figure 10: RDC Tab 'Reviews' - Special Listings 

 

Exploring Tab ‘Reports’ 

 

This tab Reports (see Figure 11: RDC Tab 'Reports') allows the generation of a blank CRF, completed CRFs 
for some specific patients or other reports, as defined by the sponsor of the study. 

 

 

Figure 11: RDC Tab 'Reports'
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eCRF Icons 

eCRF Icons for Data Entry Status 

 

Icon  CRF Label  Description  

 
Placeholder  Empty eCRF page available for new data entry.  

 
Created  

eCRF page where only header information have been completed, and 
saved as incomplete. NOT APPLICABLE TO ASP-BRIDGE STUDIES. 

 
Blank  All sections of this eCRF page are marked as blank.  

 
Pass 1 started 

Data entry started and page saved as ‘incomplete’. 

NOT APPLICABLE TO ASP-BRIDGE STUDIES. 

 
Entry Complete  Data entry finished and page saved  

 
Pass 2 Started  

(Only for documents entered by the CRO) The second pass of data 
entry has started. NOT APPLICABLE TO ASP-BRIDGE STUDIES. 

 
Pass 2 Complete  

(Only for documents entered by the CRO) The second pass of data 
entry is completed. NOT APPLICABLE TO ASP-BRIDGE STUDIES. 

 
Batch loaded  

The CRF's data were loaded by the CRO. This is an operation mainly 
in relation with central examinations.  

NOT APPLICABLE TO ASP-BRIDGE STUDIES. 

Table 1: Data Entry Status Icons 

 

eCRF Icons for Discrepancy Status 

 

Icon  CRF Label  Description  

 

No 
Discrepancies  

There are no Other or Active discrepancies associated with the CRF.  

(Note that there may be closed discrepancies associated with the CRF or 
there may open discrepancies but for another profile.)  

 
Active  

There is at least one Active discrepancy in the CRF, to be addressed by 
you.  

 
Other  

There is at least one discrepancy that must be addressed by a user in a 
role other than yours.  

Table 2: Discrepancy Status Icons 

 

Information 

If a CRF contains both Active and Other discrepancies, the icon remains red until you address the Active 
discrepancy. At that point, if the discrepancy with a status of Other is still open, the icon changes from red to 
yellow. When a CRF does not have any discrepancies, or all discrepancies are closed, the icon has no color. 
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eCRF Icons for Verification Status 

 

Verification process in Oracle RDC stands for Source Data Verification (SDV) by Clinical Operations or 
Medical Reviewers. 

 

Icon  Label  Description  

 
None  The CRF has not been verified.  

 
Verified  The CRF has been verified.  

 

Re-
verification 
Required  

At least one modification has occurred in eCRF page since the last 
verification (data change, discrepancy resolution, comment added …). The 
CRF must be re-verified.  

Table 3: Verification Status Icons 

 

eCRF Icons for Approval Status 

 

Approval process in Oracle RDC stands for the electronic signature by authorized site personnel (i.e. 
investigator). 

 

Icon  Label  Description  

 
None  The CRF has not been approved.  

 
Approved  The CRF has been approved.  

 

Re-approval 
Required  

At least one modification has occurred in eCRF page since the last approval 
(data change, discrepancy resolution, comment added …). The CRF must 
be re-approved.  

Table 4: Approval Status Icons 

 

Multiple-status CRF Icons  

 

In real situations, eCRF pages will show a combination of icons.  

 

Icon  Label/Description  

 
Entry complete, at least one active discrepancy, verified, approved.  

 

Pass 2 complete, active discrepancy requires re-verification, requires re-approval.  

NOT APPLICABLE TO ASP-BRIDGE STUDIES. 

 
 

Entry complete, other discrepancy, verified, requires re-approval, locked. 

Table 5: Multiple Status Icons 
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Data Entry 

 

In this chapter, you will work mainly with tabs ‘Home’ and ‘Casebooks’. You will focus on creating and 
modifying eCRF pages for your patients. 

 

Identify a Patient Status  

 

According to their status, patients are displayed with distinct icons in Oracle RDC 4.6. 

 

Icon  Description  

 

Patient with no data, available to start a new entry. 

 
Patient with at least one eCRF page and no discrepancy at all.  

 

Patient with at least one eCRF page and at least one discrepancy requiring an action from 
you. 

 

Patient with at least one eCRF page and at least one discrepancy requiring an action from 
another user. 

Table 6: Patient Status Icons 

 

Open eCRF Page to Enter 

 

From the ‘Home’ tab, tick the box on the left of an available patient number: . 

Select ‘Open Patient Casebooks’ in the drop-down list, and press ‘Go’: focus is moved to the ‘Casebooks’ 
tab. 

 

 

Figure 12: Open patient casebooks 

 

Verify that the ‘Casebook View’ menu corresponds to the eCRF book to complete, and select the appropriate 
visit in the upper filter area. 

Click on a page to start your entry. 

The Data Entry Window appears. 



Oracle RDC 4.6 booklet   

Data entry  

   

15 

Navigate in Data Entry Window 

 

The Data Entry Window (DEW) opens when you click on an eCRF page icon. It is composed of specific 
areas. 

 

 

Figure 13: Data Entry Window 

Page information 

 

Display identifiers for the study, site, patient, casebook and user profile. Check this bar if you are unsure 
about the page you are entering.  

 

Preferences 

 

Customize the eCRF elements to highlight depending on your activities. Choices are: 

 NONE: no highlighted element 

 ACTIVE DISCREPANCIES: highlight in red all fields with discrepancies to be managed by you. 

 ACTIVE AND OTHER DISCREPANCIES: highlight fields with discrepancies to be managed by you 
(red) or another user (yellow). 

 CLOSED DISCREPANCIES: highlight in green all fields with closed discrepancies. 

 ALL DISCREPANCIES: highlight in red, yellow or green all fields with discrepancies. 

 INVESTIGATOR COMMENTS: highlight in purple all fields with investigators comments. 

 AUDIT HISTORY: highlight in blue all fields modified since initial entry. 

 CHANGED SINCE LAST VERIFIED: highlight in blue all fields modified since last CRA SDV. 

 CHANGED SINCE LAST APPROVED: highlight in blue all fields modified since last Investigator 
signature. 
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Toolbar 

 

ADD DISCREPANCY: select an item and click on this icon to add a manual discrepancy. Only to be 
used by CRA, medical reviewers and data managers. 

 

ADD INVESTIGATOR COMMENT: select an item and click on this icon to add an investigator comment. 
Only to be used by investigators and study nurses. 

 

DELETE ROW: select a repeated row and click on this icon to delete a whole row. This feature MUST 
never be used. 

 

BLANK FLAG TOOL: click this icon to display section names and mark them as having no responses. 

 

 

Information 

Flagging a section as blank has the same meaning as crossing it out on a paper CRF: this section is 
considered as not applicable for this patient. 

 

VERIFICATION HISTORY: click this icon to display the dates when the current eCRF page has been 
verified by the CRA. 

 

APPROVAL HISTORY: click this icon to display the dates when the current eCRF page has been 
approved (electronically signed) by the investigator. 

 

DELETE CRF: click on this icon to delete the current eCRF page. After deletion, previous data of the 
eCRF page will not remain accessible from Oracle RDC, even in the audit trail. 

 

PRINT: click on this icon to send a copy of the current eCRF page to the local printer. 

 

SAVE: click on this icon to record changes applied in the eCRF page (any changes to data, 
discrepancies or comments) 

 

Navigation Buttons 

 

Click on ‘Previous CRF’ or ‘Next CRF’ to open the previous or the next page of the same visit. If you try to 
display another page without saving your modifications, the system will prompt you if you want to save it or 
not. 

These buttons are not available if the page to reach belongs to another visit. In this situation, close the 
current page. Then, from the Oracle RDC tab ‘Casebooks’, select the appropriate visit and click on the page 
to open. 
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Navigator Pane 

 

Click on the black arrow located on the right border of the DEW to 
display the ‘Navigator’ pane (see Figure 14: DEW - Navigator Pane).  

 

This pane contains 2 tabs: 

 One tab to manage ‘Discrepancies’ 

 One tab to manage ‘Investigator Comments’ 

 

Each tab is divided in two parts: 

 One part to list all discrepancies / investigator comments 
available on this eCRF page (shown as red / yellow / 
green colored bullets for discrepancies and purple bullets 
for investigator comments).   

 One part to display the details of the point selected above. 

 

The ‘Action’ dropdown list is also available at the bottom. User will 
choose in this list the action to apply to close their discrepancies. 

Figure 14: DEW - Navigator Pane 

In tab ‘Discrepancies’, the ‘Details’ section contains ‘Related values’ and ‘History’ buttons. 

Selecting ‘Related values’ displays any data points that are validated with the current selected discrepancy. 

 

 

Figure 15: Related values associated with a discrepancy 

 

The ‘History’ button opens up the discrepancy history view for the selected discrepancy.  

 

 

Figure 16: Discrepancy history view 

Click the black arrow on the top right corner or the button ‘Close’ on the lower right corner to close the 
‘Navigator’ pane. 
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Audit Trail Pane 

 

Click on the black arrow located on the lower border of the DEW to display the ‘Audit History’ pane (see 
Figure 17: DEW - Audit History Pane). When there is focus on an item in the eCRF page, this pane displays 
the history of values previously entered in this item. When focus is moved from an item to another, content of 
this pane is refreshed automatically in a few seconds. 

 

Click the black arrow pointing to the bottom to close the ‘Navigator’ pane. 

 

 

Figure 17: DEW - Audit History Pane 

 

Enter Data in eCRF page 

 

Navigation can be done with either the mouse or keyboard shortcuts. 

With the mouse, List of Values (LOV) associated to fields is displayed by clicking on the magnifying glass:  

 that appears beside the entered question. 

 

Keyboard shortcuts 

 

Tab:   Moves focus to either the next field. 

Shift Tab:  Moves focus to either the previous field. 

Spacebar:  Tick or untick the checkbox that held the focus.  

Alt+S:  Saves all updates made since the last Save or since the eCRF page was opened (same 
action as Green Floppy icon).  

Alt+L:   Opens the list of values (LOV).  

Alt+N:   Opens the next CRF in the DEW (same action as the Next CRF link).  

Alt+P:   Opens the previous CRF in the DEW (same action as the Previous CRF link).  

Ctrl+W:  Closes the Data Entry Window. 

 

Save Data Entered in eCRF Page 

 

Once data are entered or discrepancies managed, click the Green Floppy icon in the toolbar  

to save your page.  

 

Figure 18: DEW - Confirmation of page saved 
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 ‘Save complete’ means that initial entry is finished, so other users can start their review. It also 
allows automatic checks to verify the page content. This is the system default for ASP-Bridge 
studies. 

 ‘Save incomplete’ means that entry is ongoing. Once all information is collected and entered, the 
page can be saved as complete. 

 

Information 

After eCRF page entry, if you return to the eCRF tab ‘Casebooks’, you will not always see any change to the 
eCRF page icon. Click on web button ‘Refresh’ to update this area (see Figure 19: Casebooks - Refresh  
eCRF Icons). 

 

 

Figure 19: Casebooks - Refresh  eCRF Icons 

 

Modify an eCRF Page 

 

To open a page previously entered and modify it, select it as described in chapter ‘Open eCRF Page to 
Enter’. 

Each time you modify a value and move your pointer to the next field, the system displays a window ‘Reason 
for Change’ (see Figure 20: DEW - Reason for Change). Select the most appropriate reason in the list of 
values (content of this list depends on your study design). 

 

 

Figure 20: DEW - Reason for Change 
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Information 

A ‘Reason for change’ is required each time a modification is done on eCRF data after its initial entry. The 
previous value is recorded in an audit trail (see chapter about ‘Audit Trail Pane’). 

 

Insert an Investigator Comment 

 

Sometime, eCRF design does not allow entry for a comment that could help patient review or provide 
explanations for an unexpected value. Oracle RDC allows entry of a comment that is associated with an 
eCRF element (field, tick box ….) and could be reviewed later by other users. 

 

Information 

Feature ‘Investigator Comment’ is available to all users that need to enter data in eCRF. Depending on 
studies, it may include investigator, study nurses … 

 

In the eCRF page, click on the item that requires a comment, and then click on icon ‘Add Investigator 
Comment’ of the toolbar. 

 

 

Window ‘Add Investigator Comment’ appears (see Figure 21: DEW - Investigator Comment). 

Enter the comment, click OK and save your page. 

   

 

Figure 21: DEW - Investigator Comment 

 

Information 

Addition of an investigator comment is also available via a right click when pointer is focused on the 
appropriate eCRF item. Select ‘Investigator Comment’ in the contextual menu. 

 

If the investigator comment is entered after the initial page entry, it is considered as a modification to the 
page content, so it is combined with the audit trail window (see Figure 22: DEW - Audit Trail for Investigator 
Comment): comment could be entered, but a ‘Change Reason’ is also required. 
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Figure 22: DEW - Audit Trail for Investigator Comment 

 

Investigator comments can be modified at any time. To 
open an investigator comment created previously, 
open the Navigator pane.  

Select the Investigator Comment that needs to be 
modified. Detail of this comment appears in the lower 
part of the window. 

 

 Click on icon ‘Update’ to access the 
investigator comment previously entered.  

 

 

Information 

Audit history is also available in investigator 
comments. Click on button ‘History’ of the Navigator 
pane to access the investigator comments previously 
entered. 

 

 

 

Mark a section as Blank (or Not Applicable) 

 

Depending on eCRF design, a single page can contain one or several sections. In general, consecutive 
sections are separated by a horizontal line. 

Sometimes, and according to eCRF completion guidelines, it may happen that some eCRF sections are not 
applicable to a patient, either because the patient did not attend an examination or because questions do not 
correspond to his status (e.g. male and menopausal status). In a paper CRF, these sections are crossed-out. 
Oracle RDC offers the same feature, called ‘Blank Flag Processing’. 

 

If a section of an eCRF page is not applicable, click on the icon ‘Blank Flag Processing’ of the Data 
Entry Window. The related window appears. 

Figure 23: DEW - Navigator Pane for 
Investigator Comments 
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Figure 24: DEW - Blank Flag Processing 

 

There are 2 possibilities: 

 Marking this CRF as having no responses: the entire eCRF page will be considered as crossed 
out. 

 Marking one or several sections as having no responses: only the related section will be 
considered as crossed out. 

All enterable items of a blank section appear as greyed out. Audit Trail of greyed fields is no longer 
accessible when section is flagged as having no responses (see Figure 25: DEW - Example of Blank 
Section). 

 

Figure 25: DEW - Example of Blank Section 

 

 

Important 

When all fields of a section are left empty, this section will be automatically flagged as blank when 
you will save the page. 

 

Un-blanking a section as Blank (or Not Applicable) 

 

Section can be un-blanked via the same icon ‘Blank Flag Processing’. Identify the section to make available 
for data entry and un-tick the related box. 

If the section is marked as blank after the initial page entry, it is considered as a modification to the page 
content, so it is combined with the audit trail window (see Figure 26: DEW - Audit Trail for Blank Flag 
Processing): flag could be modified, but a ‘Change Reason’ is also required. 

 



Oracle RDC 4.6 booklet   

Data entry  

   

23 

 

Figure 26: DEW - Audit Trail for Blank Flag Processing 

 

 

Delete an eCRF page 

 

If an eCRF page is no longer applicable, click on the icon ‘Delete’ of the Data Entry Window toolbar. 
The related window appears (see Figure 27: DEW - Delete an eCRF Page). 

 

Important 

Page deletion could not be reversed, nor previous data accessed via RDC. Do not delete an eCRF 
page unless you are certain it should be. 

 

 

Figure 27: DEW - Delete an eCRF Page 

 

Manage an Immediate System Discrepancy 

 

Depending on eCRF design decided by the Sponsor, fields accept only some type of entries: numbers, 
characters, a maximum length, a value chosen in a list of values … If data entry does not met these criteria, 
the system raises a discrepancy when cursor is moved to the following item or menu. For example, you 
cannot enter characters in a defined lab result field that requires numerals.  
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Complete list of potential immediate discrepancy types is: 

 Length (comment too long) 

 Data type (characters entered where numbers are expected) 

 Decimal place, if number of characters after the coma exceeds the predefined length 

 Upper or Lower bound exceeded 

 Value not chosen in authorized List of Values. 

 

Information 

Field settings are defined at study setup in compliance with Protocol and Sponsor’s requirements. However, if 
you consider that an item is not associated with the appropriate format / list of values …, please inform your 
study representative. Your proposal will be submitted to the eCRF designer for review. 

 

If you enter data that conflicts with defined validation rules, Oracle RDC 4.6 alerts you accordingly with a 
‘Validation Error’ window (see Figure 28: Example of Immediate System Discrepancy). To process a 
Validation Error, check that your entered data matches the source data and:  

 Click Cancel if the entered data is incorrect or you want to navigate back to the response field. 
The ‘Validation Error’ window closes. Oracle RDC 4.6 will blank the field and return the value 
previously entered (if any) or a blank field. 

 

 

Figure 28: Example of Immediate System Discrepancy 

 

Or in rare circumstances if the value is deemed correct: 

 Enter an explanatory comment if desired. 

 Select action ‘Data Confirmed’ and click OK. The ‘Validation Error’ window closes. You can 
resume data entry. 
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Dynamism 

 

Oracle RDC 4.6 allows 3 types of dynamism to be implemented: Interval rule, DCI rule and Conditional 
branching. 

 Interval Rule 

 

Interval rules have the potential to enable one or more intervals, where an interval includes a set of visits and 
pages. 

 

For example, if the patient is considered as eligible to the study during screening visit (trigger), the baseline 
visit (target) appears into the eCRF (see Error! Reference source not found. 

Information 

This type of dynamism is reversible only in specific case.  

If the condition responsible of the dynamism is no more respected and no data has been entered in the 
interval page(s), the interval disappears. 

However, if the condition responsible of the dynamism is no more respected and data has been entered in 
the interval page(s), the interval does not disappear. 

 

 

Figure 29: Dynamism – Example of Interval rule 
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DCI Rule 

 

DCI rules have the potential to enable individual pages, based on responses to questions in the CRF. DCI 
rules can be made to apply to the current visit only or across different visits. 

 

For example, the menopausal page (target) appears only for female patient (trigger). 

(See Figure 30: Dynamism – Example of DCI rule 

). 

 

Information 

This type of dynamism is reversible only in specific case.  

If the condition responsible of the dynamism is no more respected and no data has been entered in the target 
page, the target page disappears. 

However, if the condition responsible of the dynamism is no more respected and data has been entered in 
the target page, the target page does not disappear. 

 

Figure 30: Dynamism – Example of DCI rule 

 

Conditional Branching 

 

Conditional branching supports the design of CRF pages where you are directed to a different set of 
questions on a page, depending upon the response entered for a single source question. 

 

For example, if abnormalities are observed for an examination (trigger), the field where the abnormalities 
need to be reported becomes available (target). 
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(See Figure 31: Dynamism – Example of Conditional branching 

). 

 

Information 

This type of dynamism is reversible.  

If trigger is no more respected and no data has been entered in the target field, the target field becomes 
unavailable. 

Moreover, if the trigger is no more respected and data has been entered in the target page, the target field 
becomes unavailable and data entered disappear. However, as long as the page is not saved (by clicking on 
the green floppy), the data previously entered in the target field is not deleted from system. By consequence, 
if the trigger is again respected before page is saved, the data previously entered in the target field re-
appear. 

 

 

 

Figure 31: Dynamism – Example of Conditional branching 
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3. Discrepancy Management 

 

eCRF is designed to collect specific data in pre-formatted fields. Oracle RDC 4.6 verifies data entry, and it 
eventually raises some discrepancies to alert users about a potential problem with data format or 
consistency. Depending on problem identified, discrepancies are generated at specific time points: 

 During data entry, when you move focus out of the concerned field. It involves all simple 
discrepancies about data format. Please refer to chapter ‘Manage an Immediate System 
Discrepancy 

 ’ to learn more about their management. 

 When a page is saved after a page entry or modification. These discrepancies compare data 
collected within one eCRF page. 

 The day after eCRF pages entry or modification. These discrepancies compare data collected 
among several eCRF pages. 

 Finally on a regular basis according to study specification. It concerns mainly complex 
discrepancies that require a manual review before posting to the eCRF, or reconciliation with 
external data such as randomization system data or centralized laboratory results. These 
discrepancies are generally displayed several days after eCRF page entry or modification. 

 

This chapter describes how to manage the three last types of discrepancies from the eCRF page itself or via 
a dedicated interface of Oracle RDC 4.6. 

 

Identify Patients and Pages with Discrepancies 

 

Oracle RDC 4.6 displays colors for patients and pages according to their discrepancy statuses: 

 A red patient icon means there is at least one active query to be managed by you for this patient. 
According to chapter ‘eCRF Icons for Discrepancy Status', it also means there is at least one 
page displayed as red for this patient. 

 

 

 

 A yellow patient icon means there is no discrepancy active for you, but other users have to 
manage discrepancies that are open for them. 

 

 

 

Important 

As an Oracle RDC 4.6 user, you are supposed to manage all discrepancies displayed as RED for 
you. You are not authorized to manage yellow discrepancies since they should be managed by 
another user. Green discrepancies cannot be managed because it is a final status, the query is 
closed.  
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Manage all Active Discrepancies 

 

Discrepancies can be managed manually, patient by patient, visit by visit, page by page or in any sequential 
order as described in chapter ‘Manage a Single Discrepancy’. It is also possible to access them from a 
specific module of Oracle RDC 4.6 to focus on problems only. 

 

From Oracle RDC 4.6 homepage, select the patients with red icons only and choose Review Discrepancies in 
the drop-down list above the list of patients (see Figure 32: Discrepancies - Select Patient with 
Discrepancies). Press Go. 

This link opens the Discrepancy Review tab with a pre-entered filter on active and other discrepancies for 
your selected patients.  

CRA and Medical reviewers will also select patients with Yellow icons if they want to check discrepancies 
currently addressed to the site. 

 

 

Figure 32: Discrepancies - Select Patient with Discrepancies 

 

It is also possible to reach manually this section: from Oracle RDC 4.6 homepage, select the tab ‘Review’, 
and then sub-tab ‘Discrepancies’ (see Figure 8: RDC Tab 'Review' - Discrepancies 

This manual selection allows focusing only on ‘active discrepancies’ instead of ‘active and other 
discrepancies’. 

 

To manage all discrepancies addressed to you, perform a filter with the ‘Search’ section of the page: select 
the discrepancy status ‘Active’ on the last filter box. Click Go. 

 

 

Figure 33: Review Discrepancies - Search Pane 
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It is also possible to combine one or more specific filters: 

 Manage a range of patients only by selecting first and last patients with the magnifier glass. 

 Manage discrepancies according to eCRF page status (entry started or complete, page verified 
by CRA or not, page approved or not, etc ) 

 Manage discrepancies of specific eCRF visits or pages only 

 

Information for CRA / Medical Reviewers 

From the Search pane, of the Discrepancy Review tab, users can also select ‘Open (Active and Other)’ 
Discrepancies to review both their discrepancies (red ones) and those that should be answered by the site 
(yellow ones).  

 

Filtering Active discrepancies displays all red queries for your site (see Figure 34: Review Discrepancies - 
Search Result). This section contains one query per row, ordered by patient, visit and page. To access 
discrepancy details from the search results, click the hyperlinked text or details icon. To access the CRF from 
here, click on the CRF icon. 

 

 

 

Figure 34: Review Discrepancies - Search Result 

 

Click on the Detail icon of a row to check a single discrepancy. The ‘Discrepancy Details’ window 
provides details about error message, concerned values and discrepancy history (see Figure 35: 

Discrepancy Review - Discrepancy Details Window). 
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Figure 35: Discrepancy Review - Discrepancy Details Window 

 

Section ‘Related Values’ refers to the one described in chapter ‘Manage a Single Discrepancy’. It lists all 
values in relation to the current discrepancy, in order to determine with a quick overview which value(s) has 
generated the potential error. However, this Discrepancy Details window also provides a direct link to the 
concerned pages (see Figure 36: Discrepancy Review - Open Page from Details Window). 

 

 

Figure 36: Discrepancy Review - Open Page from Details Window 

 

From this point, discrepancy is then managed as described in chapter ‘Manage a Single Discrepancy’: 

IF AN UPDATE IS REQUIRED, go to the concerned item and modify the entry according to your 

source documents. The system will prompt you for a Reason for Change: enter the one that is 
the most appropriate to your situation (see Figure 20: DEW - Reason for Change).Figure 21: DEW - 

Investigator CommentReturn to your discrepancy message and choose action ‘Data Updated’ in the 
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dropdown list Action at the bottom of the navigator pane. At this stage, Oracle RDC 4.6 prompts 
you for an optional comment (see Figure 39: Discrepancies - Optional Comment). Click OK and 
save your page. 

 IF NO UPDATE IS NECESSARY, open your discrepancy in the Navigator pane and choose ‘Data 

Confirmed’ in the dropdown list Action. At this stage, Oracle RDC 4.6 prompts you for an optional 
comment (see Figure 39: Discrepancies - Optional Comment). When confirming a value, a 
comment is most welcome for avoiding repeating re-queries. Click OK and save your page. 

 

Once the eCRF page is closed, close the Discrepancy Details window. 

 

The discrepancy is still present in the Discrepancy Review tab, and the associated page is still red. Click on 
button Refresh on the left side of the section. Depending on its origin, an answered discrepancy will: 

 Disappear from the Discrepancy Review window if your eCRF update solves the automatic 
check. Associated page will also appear with no colour, unless there is another open discrepancy 
related to this page. 

 Become yellow in the Discrepancy Review window if the query was confirmed or created 
manually by another user and should be closed by him. Associated page will become yellow until 
the final resolution by another user, unless there is another open discrepancy related to this 
page. 

 

 

Figure 37: Resolution of discrepancy by a user 

 

All discrepancies are to be managed until all of them are yellow or have disappeared. 

 

Manage a Single Discrepancy 

 

From the ‘Home’ tab, identify a patient who has a discrepancy to manage (patient’s icon is red). Select this 
patient and select ‘Open Patient Casebooks’. Press Go. 

Open the eCRF page of this patient that is red. This page can be at any patient’s visit. 

By default, all fields in relation to open discrepancies are displayed in red. 
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Information 

Even if there is only one discrepancy on an eCRF page, if this discrepancy involves several fields, all these 
fields will be red: number of red fields does not represent the number of open discrepancies. 

In addition, if the same discrepancy involves fields on other pages too, these fields will appear as red when 
pages will be open. 

 

 

To read discrepancy text in relation to red fields, open the ‘Navigator’ pane on the right side of the window. 

Several discrepancies may be open at the same time on the same page. Discrepancies are then figured out 
as several colored bullets in the Discrepancies tab of the Navigator pane. To access the one that is relevant 
for the highlighted field(s) you want to manage, click on this eCRF field: the focus will be done on this specific 
bullet in the Navigator pane. Click on this bullet to display the related error message. 

 

Read the discrepancy text. To understand why this error has been generated, click on the ‘Related Values’ 
button of the Navigator pane: Oracle RDC 4.6 displays all values involved in the check, even those that have 
been entered on another page (see Figure 38: Discrepancies - Related Values). 

 

Information 

Using the Related Values button saves time because it gives you an overview of the potentially discrepant 
eCRF content without opening multiple eCRF pages to check your entry. From this overview, you can decide 
which value should be corrected (if any), and then go and correct the appropriate field.  

 

 

Figure 38: Discrepancies - Related Values 
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After a review of all data involved in a discrepancy, you can decide whether the eCRF requires an update or 
if the current entry is confirmed. 

IF AN UPDATE IS REQUIRED, return to the concerned item, and modify the entry according to your 
source documents. The system will prompt you for a Reason for Change: enter the one that is 
the most appropriate to your situation (see Figure 20: DEW - Reason for Change).Figure 21: 
DEW - Investigator CommentReturn to your discrepancy message and choose action ‘Data 
Updated’ in the dropdown list Action at the bottom of the navigator pane. At this stage, Oracle 
RDC 4.6 prompts you for an optional comment (see Figure 39: Discrepancies - Optional 
Comment). Click OK and save your page. 

 

 IF NO UPDATE IS NECESSARY, after a complete review of all items concerned by the discrepancy via 
the button ‘Related Values’, and you consider that your entry is appropriate and do not need to 
be modified, open your discrepancy in the Navigator pane and choose ‘Data Confirmed’ in the 
dropdown list Action. At this stage, Oracle RDC 4.6 prompts you for an optional comment (see 
Figure 39: Discrepancies - Optional Comment). When confirming a value a comment is most 
welcome for avoiding repeating re-queries. Click OK and save your page. 

 

 

Figure 39: Discrepancies - Optional Comment 

 

Depending on its origin, an answered discrepancy will: 

 Disappear from the Navigator pane if your eCRF update solves the automatic check. Fields 
involved in the check will also appear with no colour, unless there is another open discrepancy 
related to these fields. 

 

 

Figure 40: Discrepancies - Look of a Closed Atomatic Discrepancy 
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 Become yellow if the query was confirmed or created manually by another user and should be 
closed by him. Fields involved in the discrepancy will become yellow until the final resolution by 
another user, unless there is another open discrepancy related to these fields. After the final 
resolution by this user, fields and discrepancy will appear as green. 

 

 

Figure 41: Discrepancies - Look of an Answered Manual Discrepancy 

 

 

Access all Active Discrepancies from Homepage 

 

From the Homepage of Oracle RDC 4.6, there is a link to 
access directly all active discrepancies to manage. 

In the section ‘Activities’ from Home tab, click on the link 
‘Review XX Active Discrepancies’ (see Figure 42: Access all 
Active Discrepancies from Homepage 

). This link will open the Review Discrepancies tab, with a 
filter already applied on all active discrepancies (red ones). 

 

Information for CRA / Medical Reviewers 

The link ‘Review XX Other Discrepancies’ works the same, it 
will display all open queries to be managed by other users 
(i.e. site users) as yellow for you. This link is useful to have a 
global overview of site activities before a monitoring visit. 

 

 

 

F
igure 42: Access all Active 
Discrepancies from Homepage 
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Discrepancy Management Wrap-Up 

 

 Only Red discrepancies are to be managed. 

 Answered discrepancies, depending on their origin, will  

o become Yellow if your answer needs a peer review 

o become Green after review of your answer by another user 

o disappear if your answer closes an automatic question 

 Do never apply an action on a discrepancy that does not appear as Red because this one is not 
intended for you. Data Management will regularly produce listings to review discrepancies not 
answered by the appropriate user and will resend them.  

 Discrepancies can be managed on a page-by-page basis or globally from the Discrepancy 
Review tab. This last solution is more comfortable to answer several open discrepancies. 
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4. Manual Queries 

 

Oracle RDC allows users with sufficient privileges to address some manual queries to the site for clarification. 
Each manual query sent by a user should be verified and closed by a user with the same privilege level after 
site review. 

 

Creation of a manual query in the eCRF 

 

Inside the eCRF page, identify the data which requires a site review. Place the pointer on this field and right 
click: from the contextual menu, choose ‘Add discrepancy’.  

A window ‘Add discrepancy’ appears (see Figure 43: Manual query - add a query). Several fields are to be 
completed: 

 

 

 

Figure 43: Manual query - add a query 

 

1. Reason: this field defaults to ‘DM Query’, choose the appropriate reason to suit your role. For 
example, if you are a CRA, choose ‘CRA query’, or ‘MR query’ if you are a Medical reviewer …  

 

Important 

If the field ‘Reason’ is not properly completed per your profile in Oracle RDC, you will NEVER be 
forwarded the answer to this query, so follow up will be impossible. 
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2. Description: it is the place where the question should be asked. 

3. Action: indicate from the codelist who is the addressee of this manual query. For the investigator, 
select ‘To be reviewed by site’. 

4. Click ‘OK’ to validate your entry. 

 

The related field will then appear as yellow with your profile (unless there is another query to be 
answered by you on the same field) and red for the investigator. Investigator will then view and manage 
this query as any other system queries. 

 

Information 

Only one manual query can be created on one field. It includes manual queries already closed. If you try to 
create a manual query on a field already associated to a previous manual query, the query text will appear 
pre-populated with the previous query text. Click then on ‘Cancel’ and create your query on another field of 
the same eCRF page. Alternatively you can create a ‘Section Discrepancy’ instead of ‘Field Discrepancy’. 

 

Reviewing and closing manual queries 

 

Immediately after the management of a manual query by the site staff, this query is displayed as yellow for 
the site and not accessible for issuer of the query. The Data Manager will forward on a daily basis the 
answered query to the CRA or MR, it is only after this action that it will appear as red for the issuer deemed 
most appropriate to deal with the query at this stage. If your profile allows query management, it is possible to 
access these queries from 2 paths: 

 Either follows the link ‘Review XX active discrepancies’ from the Oracle RDC Homepage (see 
Figure 44: Manual queries - Select answered queries). 

 

 

Figure 44: Manual queries - Select answered queries 

  

 Or, from the ‘Review – Discrepancy’ tab, expand the Search pane and apply the filter 
Discrepancy status ‘Active’, press Go and sort the answered queries of your site by Review 
Status (click on the column label with the same name to sort table content) (see Figure 45: 
Manual queries - Select answered queries - List). 
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Figure 45: Manual queries - Select answered queries - List 

  

From this list of queries with review status ‘CRA VERIFY, open the queries by clicking on the page icon at the 
end of each line.  

 

Inside the eCRF page, display the Discrepancy 
management pane and identify your manual query. Check 
the consistency of the answer with your question: 
investigator answer may consist in eCRF update or in a 
note reported in the field ‘Comment’. Depending on the 
answer, the query may require to be resent to the site for 
further clarification, or can be closed immediately. 

 

 If the query is to be resent to the site, just apply 
action ‘To be reviewed by site, and update the 
query text to add more details if necessary and 
press Go. 

 

 Otherwise, if the answer corresponds to the 
question, close the query with action ‘CRA – 
Resolved’ and press Go. A pop-up window 
‘Discrepancy Action’ will then require a 
‘Resolution Reason’. Select in the codelist the 
most appropriate one within ‘Data updated’ or 
‘Data confirmed’. 

 

F
i
g 

Figure 46: Manual queries - Manage answered queries 

 

When page will be saved, the field where the manual query was created will appear as yellow in case the 
query was resent, or as white in case the query was closed. 
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5. Investigator Comments Review 

 

Investigator Comments Selection 

 

Investigator Comments are reported at an item level in eCRF pages.  
They can be reviewed manually, i.e. by entering each eCRF page and 
reviewing its whole content, or globally. 

 

The easiest, but also less specific way, to open all investigators 
comments is to click on the link ‘Review Investigator Comments’ from the 
section ‘Activities’ on the left of Oracle RDC 4.6 homepage (see Figure 
47: Access all Investigator comments for review from Homepage 

). This link will open the Review – Investigator Comments tab and display 
all investigator comments for all patients, all pages. 

Figure 47: Access all Investigator 
comments for review from 
Homepage 

 

It is also possible to select only some 
patients to review. From Oracle RDC 4.6 
homepage, select required patients only 
and choose Review Investigator 
Comments in the drop-down list above 
the list of patients. Press Go.  

This link opens the Investigator 
Comments Review tab with comments 
displayed for your selected patients.  

 

 

Figure 48: Access patient specific Investigator comments for review  

 

Finally, it is also possible to open directly the Review - Investigator Comments tabs and apply a manual filter 
at this step (e.g. on all informed consent pages, date of birth …). 

 

Information for CRA / Medical Reviewers 

The addition of an investigator comment on a page removes the status ‘verified’. If all your pages were 
verified at the last visit and you want to review all new comments, go in Review – Investigator Comments tab, 
unfold the Search pane, and apply a filter on all eCRF pages ‘Awaiting Re-Verification’. Only new or modified 
comments will be displayed. 
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Investigator Comments Review 

 

List displayed in Review – Investigator Comments tab contains patient, visit and page identifiers. Each 
comment is associated with the name of the item it was created on as well as its current value. If needed, the 
whole eCRF page where the comment stands can be displayed by clicking the page icon at the right end of 
the row. 

 

 

Figure 49: Investigator Comments - Review All Comments 

 

For more details about management of investigator comments inside a page, please see chapter  

Insert an Investigator Comment. 
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6. eCRF Page Verification (for CRA only) 

 

Source Data Verification is an important step in eCRF processing. If this step is not done regularly, it will 
become more and more difficult to identify new or modified eCRF data from one monitoring visit to the 
following one. It is recommended to flag a page as verified as soon as it has been checked. A page can have 
different statuses regarding verification: 

 NOT VERIFIED: the Source Data Verification process has not started on this page, or the verification 
status has intentionally been removed from this page by the CRA (see Verification Undone). 

 VERIFIED: data reviewed and approved by the CRA 

 AWAITING RE-VERIFICATION: page has been verified at least once, but a change on data, 
discrepancies or comments has occurred since this verification. Modified content needs to be 
checked again. 

 VERIFICATION UNDONE: verification status has been applied by mistake so CRA has removed it. This 
status is included in Not Verified pages. 

 

Please see chapter eCRF Icons for Verification Status for related eCRF icons in workspace. 

 

Find eCRF Pages to Verify 

 

‘Activities’ section from the Oracle RDC 4.6 homepage proposes a 
direct link to ‘Review non-blank CRFs ready for initial verification’ (see 
FFigure 50: Verification - Review non-blank CRFs ready for initial 
verification 

). This link will open the Review CRFs tab, with a filter pre-defined on 
pages complete, without open discrepancies and never verified before.  

That is an easy point to start verification activities, however it will not 
allow a complete check of your site CRFs.  

Please follow the steps below for a complete overview of the 
verification process. 

FFigure 50: Verification - Review non-
blank CRFs ready for initial verification 

 

From Oracle RDC 4.6 homepage, select the Review tab, and then sub-tab CRFs (see Figure 7: RDC Tab 
‘Review’ - CRFs). Then, in the Search pane, put the Verification status to ‘Not Verified’. Press Go. 

This manual selection focuses only on eCRF pages that have never been verified (including pages flagged 
as having no data, i.e. blank pages). 

 

Figure 51: Verification - List of Pages to Verify 
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Each row describes eCRF page properties: identifiers, dates for modification, verification, approval and lock. 
Click on eCRF page icon at the right end of the row to open the corresponding page and review its content. 

 

Verify eCRF pages 

 

Once verification of the page content is finished, it should be marked as ‘Verified’ by the CRA. It can be done 
page-by-page, or globally for a selection of pages. 

 

Mark a Single Page as Verified 

 

Open the page to flag as ‘Verified’. On the toolbar, press icon Verify.  

 

 

 

The window ‘Verify CRF’ appears (see Figure 52: Verification - Comment Window). An optional comment can 
be added at this stage. This window will also list all previous actions in relation to the verification process: 
date of the initial signature, when signature was removed, when page has been re-signed, etc. 

 

 

Figure 52: Verification - Comment Window 

 

Press Verify and save the page with the green floppy. A message warned you that nothing has changed, so 
there is no need to save the page, because content has not changed. Your signature is however taken into 
account and recorded. 

Close the page and return to the workspace. Click on Refresh to update the eCRF 
page icon. The page is now flagged with a tick box.  

 

 

Information 

eCRF pages that have been modified after application of a verification status appear with a red 
arrow beside the tick box. These pages should be verified again. Modifications can be a data 
change, an answered query or a comment created.  
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Mark Several Pages as Verified 

 

From Oracle RDC 4.6 homepage, select the Review tab, and then sub-tab CRFs (see Figure 7: RDC Tab 
‘Review’ - CRFs). Then, in the Search pane, select the Verification status ‘Not Verified’. Press Go. 

The list of pages appears as described in Figure 51: Verification - List of Pages to Verify. 

Once pages content checked, tick the box beside each eCRF pages to flag as verified, and select Verify in 
the menu above the list of pages. Press Go (see Figure 53: Verification - Verify Several Pages process 

). 

A window Verify CRFs appears. Default is to approve all eCRF pages selected previously except those that 
have discrepancies. Verification status will indeed be removed when these discrepancies will be answered. 
You can however bypass this by un-ticking the box. You will at least know that these pages have been 
verified at least once, and then need to review only changes. 

Press on Continue. 

 

 

Figure 53: Verification - Verify Several Pages process 

 

After an intermediate step to confirm your operation (Press Yes), system displays a confirmation message 
with the number of pages verified. The workspace is refreshed and pages now appear with the tick box. 
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Figure 54: Verification - Verify Several Pages confirmation 

Find eCRF Pages to Re-Verify 

 

Re-verification is needed for pages that have been modified since the previous check. Process is the same 
as described in chapter Mark Several Pages as Verified, except that selection in Search pane should be 
verification status: ‘Awaiting Re-Verification’. 

 

Figure 55: Verification - List of Pages to Re-Verify 

 

Remove Verification Status 

 

If a verification status has been applied by mistake on one or several pages, it can be removed by the same 
way it was put. 

 

For a single page, click on the Verify icon of the eCRF toolbar. Check the verification history and click on 
button ‘Undo Verification’ (see Figure 56: Verification - Remove for a Single Page). Save your page and 
refresh the workspace : the tick box does not appear anymore on the eCRF page icon. 

 

 

Figure 56: Verification - Remove for a Single Page 

  

For a range of pages, apply the appropriate filter in the Search pane of Review CRFs tab (e.g. pages verified 
for the concerned patients only) and press Go. Tick the boxes for all pages to un-verify, and select UnVerify 
in the menu above the list of pages. Press Go. A window Undo Verification on CRFs appears. Press 
Continue (see Figure 57: Verification - Remove for a Range of Pages). 

After an intermediate step to confirm your operation (Press Yes), system displays a confirmation message 
with the number of pages unverified. The workspace is refreshed and selected pages now appear without the 
tick box. 
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Figure 57: Verification - Remove for a Range of Pages 
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7. eCRF Approval / Signature (for Investigator only) 

 

eCRF Approval is an important step in processing: it is the electronic equivalent of the paper CRF signature. 
Signature is generally applied after the page verification by the CRA, because any change required by the 
CRA would remove the approval status. 

It can be applied by any site-user that has been granted that right by the Sponsor: it is generally the principal 
investigator and/or co-investigators. Study nurses are not given the right to sign eCRF pages. 

All eCRF pages should be signed before to close the study. Sponsor can make it mandatory for different 
milestones or at the end of the study, investigator can however sign pages on a more frequent basis than 
Sponsor’s requirements. 

A page can have different statuses regarding signatures: 

 NOT APPROVED: the investigator has not signed this page, or the approval status has intentionally 
been removed from this page by the investigator (see Approval Undone). 

 APPROVED: data reviewed and signed by the investigator. 

 AWAITING RE-APPROVAL: page has been signed at least once, but a change on data, discrepancies or 
comments has occurred since this signature. Modified content needs to be signed again. 

 APPROVAL UNDONE: approval status has been applied by mistake so investigator has removed it. This 
status is included in Not Approved pages. 

 

Please see chapter eCRF Icons for Approval Status for related eCRF icons in workspace. 

 

Find eCRF Pages to Approve 

 

‘Activities’ section from the Oracle RDC 4.6 homepage proposes a 
direct link to ‘Review non-blank CRFs ready for initial approval’. This 
link will open the Review CRFs tab, with a filter pre-defined on pages 
complete, without open discrepancies and never approved before.  

 

That is an easy point to start approval activities; however it will not 
allow a complete check of your site CRFs.  

Please follow the steps below for a complete overview of the 
approval process.      
     

Figure 58: Page approval - Review  

non- blank CRFs ready for initial approval
     

From Oracle RDC 4.6 homepage, select the Review tab, and then sub-tab CRFs. Then, in the Search pane, 
put the Approval status to ‘Not Approved’. Press Go. 

 

  

 

Figure 59: Page approval - Searching for pages requiring approval 
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This manual selection focuses only on eCRF pages that have never been signed (including pages flagged as 
having no data, i.e. blank pages). 

 

 

Figure 60: Approval - List of Pages to Approve 

 

Each row describes eCRF page properties: identifiers, dates for modification, verification, approval and lock. 
Click on eCRF page icon at the right end of the row to open the corresponding page and review its content. 

 

Approve eCRF pages 

 

Once check of the page content is finished, it should be marked as ‘Approved’ by the investigator. It can be 
done page-by-page, or globally for a selection of pages. 

 

Mark a Single Page as Approved 

 

Open the page to flag as ‘Approved’. On the toolbar, press icon Approve.  

 

 

The window ‘Approve CRF’ appears (see Figure 61: Approval - Comment Window). An optional comment 
can be added at this stage. This window will also list all previous actions in relation to the approval process: 
date of the initial signature, when signature was removed, when page has been re-signed … 

 

 

Figure 61: Approval - Comment Window 
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Press Approve and complete the next window (CRF Approval Signoff) with your Oracle RDC 4.6 login and 
password. System displays a window to confirm the new status of the page. Press Close. 

 

 

Figure 62: Approval - One Page Signature & Confirmation 

 

Save the page with the green floppy. Close the page and return to the workspace. Click on Refresh to update 
the eCRF page icon. The page is now flagged with a signature at the bottom of the icon.  

 

 

Information 

eCRF pages that have been modified after application of an ‘Approved’ status appear with a red arrow beside 
the signature. These pages should be signed again. Modifications can be a data change, an answered query 
or a comment created.  

  

 

Mark Several Pages as Approved 

 

From Oracle RDC 4.6 homepage, select the Review tab, and then sub-tab CRFs (see Figure 7: RDC Tab 
‘Review’ - CRFs). Then, in the Search pane, select the Approval status ‘Not Approved’. Press Go. 

The list of pages appears as described in Figure 60: Approval - List of Pages to Approve. 

Once pages content checked, tick the box beside each eCRF pages to flag as approved, and select Approve 
in the menu above the list of pages. Press Go. 

 

A window Approve CRFs appears (see Figure 63: Approval - Approve Several Pages). Default is to approve 
all eCRF pages selected previously except those that have discrepancies and those not verified yet by the 
CRA. Approval status will indeed be removed when discrepancies will be answered or verified by the CRA. 
You can however bypass this by un-ticking the boxes. You will at least know that these pages have been 
signed at least once, and then need to review only changes the next time. 
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Figure 63: Approval - Approve Several Pages 

 

After an intermediate step to confirm your operation, system displays a confirmation message with the 
number of pages verified. The workspace is refreshed and pages now appear with the signed icons. 

 

 

Figure 64: Approval - Confirmation of Approval for Several Pages 

 

Find eCRF Pages to Re-Approve 

 

Re-approval is needed for pages that have been modified since the previous check. Process is the same as 
described in chapter Mark Several Pages as Approved, except that selection in Search pane should be 
approval status: ‘Awaiting Re-Approval’. 

 

 

Figure 65: Page approval - Searching for pages requiring re-approval 
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Remove Approval Status 

 

If an approval status has been applied by mistake on one or several pages, it can be removed the same way 
it was put. 

 

For a single page, click on the ‘Approval icon’ of the eCRF toolbar.  

Check the approval history and click on button ‘Undo Approval (see Figure 66: Approval - Remove for a 
Single Page). The system requires entering your Oracle RDC 4.6 login and password. After the confirmation 
message, save your page and refresh the workspace : the signature does not appear anymore at the bottom 
of the eCRF page icon. 

 

 

Figure 66: Approval - Remove for a Single Page 

  

For a range of pages, apply the appropriate filter in the Search pane of Review CRFs tab (e.g. pages 
approved for the concerned patients only) and press Go. Tick the boxes for all pages to un-sign, and select 
UnApprove in the menu above the list of pages. Press Go. Your Oracle RDC 4.6 login and password are 
required. A window UnApprove CRFs appears. Press Continue. 

After an intermediate step to confirm your operation, system displays a confirmation message with the 
number of pages unsigned. The workspace is refreshed and selected pages now appear without the signed 
icon. 

 

 

 

Figure 67: Approval - Remove for a Range of Pages 
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10. About Quintiles 

 

Quintiles, Navigating the new health 

 

Each Quintiles company has won industry respect and customer loyalty by combining highly specialized skill 
sets – such as therapeutic area expertise and an understanding of global and local regulatory environments – 
with an uncommon dedication to providing superlative service. 

 

Together, our 21,000 specialized employees play an unequaled role in improving healthcare worldwide by 
providing a broad range of professional services, information and partnering solutions to the pharmaceutical, 
biotechnology and healthcare industries. In fact, Quintiles companies have helped develop or commercialize 
every one of the world’s top 30 best-selling drugs. 

 

Founded in 1982 by Dennis Gillings, Ph.D., CBE, and headquartered near Research Triangle Park, North 
Carolina, we have offices in more than 50 countries and provide services in many more. 

 

Our competitive edge lies in our ability to leverage data, therapeutic expertise, full-service capabilities and 
global resources through an integrated information technology network. We hone our competitive edge by 
constantly scanning the horizon for opportunities and offering our customers the best information to 
accelerate and improve healthcare decisions. 

 

Corporate Snapshot 

 

We help customers succeed by providing services and solutions via three major groups: 

 

QUINTILES® product development services, which provides all clinical research aimed at regulatory 
approval, and post-launch research and consulting on product safety and value. 

 

 Phase I Services for early-phase human drug development.      

 Global Clinical Development Services, encompassing all Phase II-IV trial services, such as clinical trial 
management, medical and regulatory affairs, biostatistics, patient recruitment, ECG services, and drug 
safety and strategic research. 

 Global Central Labs to support all phases of clinical trials. 

 Global Data Management to capture, analyze and report patient-related data. 

 Global Consulting on product development; reimbursement and pricing; health outcomes; regulatory 
compliance (e.g., FDA enforcement, quality systems); and due diligence for pharmaceutical, biotech and 
medical device companies. 

 Medical Education involving the development and delivery of Continuing Medical Education (CME) 
programs for health care practitioners. 

 

INNOVEX® commercialization, responsible for sales force and medical communication services. 

 

 Sales solutions, including the recruitment, training and deployment of customer- or Innovex-managed 
primary and secondary sales teams; health management services; and vacancy management. 
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 Medical communications to promote physician education and communications programs, including 
symposia, exhibition support at major scientific congresses, advisory boards and publication planning. 

 

NOVAQUEST® strategic partnering solutions to help pharmaceutical and biotech companies optimize 
portfolio development, company growth and profits through innovative, tailored financial and strategic 
solutions. 

 

 Structured finance: tailored financial solutions for customers needing financial support via funding, 
development or commercialization services. 

 Strategic resourcing: long-term, strategic outsourcing or insourcing relationships that reduce fixed costs 
and increase resource flexibility. 

 eBio: Specialized strategic and financial solutions for emerging biotech and pharma companies. 

 

Further differentiating Quintiles' service delivery is its access to unique patient-level healthcare information 
and data products. 
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